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Chapter 1

Introducing InTouch Modern
Applications

Modern InTouch applications give you the capability to easily 
integrate ArchestrA symbols directly into your applications. You 
simply drag ArchestrA or Situational Awareness Library symbols from 
WindowMaker’s ArchestrA Graphic Toolbox into Modern application 
windows. All configuration steps to use ArchestrA Graphics are 
completed from InTouch WindowMaker.

Modern applications combine the capability inherent in ArchestrA 
symbols with the familiar workflow of legacy InTouch applications.
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Working With InTouch Modern Applications
The following figure summarizes the workflow of managing and 
configuring Modern applications. Most management tasks are 
completed from InTouch Application Manager to:

• Create Modern applications

• Open and edit Modern applications

• Export and import Modern applications

• Migrate earlier versions of InTouch applications to Modern 
applications

• Publish Modern applications

• Delete Modern applications

Most Modern application configuration tasks are done from 
WindowMaker to:

• Configure support for other languages

• Configure the Application Style Library

• Configure Alarm Priority Mapping

• Export and import ArchestrA symbols

• Import client controls

• Configure NAD support

• Export and import localizaiton strings for symbols
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Chapter 2

Managing InTouch Modern
Applications

This chapter includes the following topics that explain how to create 
and manage your InTouch Modern applications from the InTouch 
Application Manager. 

Creating an InTouch Modern Application

Editing an InTouch Modern Application

Exporting a Modern Application

Importing an InTouch Modern Application

Migrating to an InTouch Modern Application

Publishing an InTouch Modern Application

Deleting an InTouch Modern Application
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Creating an InTouch Modern Application
You create a Modern InTouch application from InTouch Application 
Manager. When you create a Modern InTouch application, you must:

• Provide a base folder path to save your Modern applications.

• Specify the name of a folder that stores the Modern application’s 
files.

• Specify the name of the application.

After creating a Modern application you can access the Modern 
application’s folder to define it as NAD master folder, share the folder 
on the network, and copy additional files to the folder. 

Important:  You cannot use Windows Explorer to move a Modern 
application's folder after it has been created. Use the Modern 
application export and import options to move your Modern application 
to another folder or computer.

To create an InTouch Modern application

1 Open InTouch Application Manager.

2 Select New by one of the following methods:

a Select New from the File menu.

b Right-click within Application Manager and select New from 
the shortcut menu.

c Select the New icon from the menu bar.

d Press the Ctrl + N keys.

The Create New Application wizard appears with options to create 
a Modern or legacy application.
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3 Select Modern InTouch Application and click Next.

The Create New Application wizard updates to show a field to 
enter a base directory path to save InTouch applications.

4 Click Browse and select a directory path.

5 Click Next.

The Create New Application wizard updates to show a field to 
enter the name of the folder for the new Modern application being 
created.

6 Type the name of the folder and click Next.

The Create New Application wizard updates to show fields to 
enter a name and a description of a new Modern application.

7 Type the name of the Modern application in the Name field.

Important:  Application names must be 32 characters or less.

8 If you want, enter an optional description of the application in the 
Description field.

The description appears in the Description column of Application 
Manager’s list of applications.

9 Click Finish.

A horizontal bar shows the progress of creating a new Modern 
application. After the application is created, it appears in 
Application Manager’s list of applications.
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Editing an InTouch Modern Application
Opening a Modern application is similar to a legacy InTouch 
application. You open a Modern application from the InTouch 
Application Manager to edit in WindowMaker or run in 
WindowViewer. 

To open and edit a Modern application

1 Open InTouch Application Manager showing InTouch applications 
listed by name.

2 Double-click on the name of a listed Modern application to open it 
in WindowMaker.

You can also open Modern application by other methods:

a Click on the Modern application’s name to select it.

b Do one of the following:

• Select WindowMaker from the File menu.

• Right-click within Application Manager and select 
WindowMaker from the shortcut menu.

• Select the WindowMaker icon from the menu bar.

• Press the Ctrl + M keys.

3 Save your editing changes to a Modern application.

When you edit an InTouch Modern application, your changes are 
saved to the application folder.

4 Close the application.
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Exporting a Modern Application
To copy or share a Modern application, you can export an application 
to an aaPKG file. Then, you can import the application with another 
name or to another folder or computer.

An exported aaPKG file contains the Modern application’s:

• ArchestrA Graphic Toolbox

• Application Style Library

• Alarm Priority Mapping

• Language strings

• Application folder contents

To export a Modern application

1 Open InTouch Application Manager.

2 Click on a Modern application name to select it from Application 
Manager’s list of InTouch applications.

3 Select the Export wizard by one of the following methods:

a Select Export from the File menu.

b Right-click within Application Manager and select Export from 
the shortcut menu.

c Select the Export icon from the menu bar.

d Press the Ctrl + E keys.

The Export InTouch Application wizard appears with a field to 
name the export file. The default name of the export aaPKG file is 
the application name.
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4 If desired, change the export file name and the destination folder 
to save the export file.

5 Click Save.

A horizontal bar shows the progress of exporting the application. 
After the export operation is complete, Window Explorer opens to 
show the exported aaPKG file in the designated folder.
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Importing an InTouch Modern Application
You can create a new Modern InTouch application by importing an 
existing Modern InTouch application package file or a legacy InTouch 
application. However, published Modern applications cannot be 
imported to create a new application.

Importing an exported Modern InTouch application also imports the 
application’s existing style library, Alarm Priority mapping, and 
language strings.

Importing a Modern application:

• Creates a new InTouch application folder under a base application 
folder path you select.

• If the import source is an aaPKG file, ArchestrA graphics are 
imported and replace the existing ArchestrA graphics. 

To import a Modern application

1 Open InTouch Application Manager.

2 Select the Import wizard by one of the following methods:

a Select Import from the File menu.

b Select the Import icon from the menu bar.

c Press the Ctrl + I keys.

The Import InTouch Application wizard appears with buttons and 
fields to select the root folder of a legacy InTouch application or an 
exported Modern application package file (aaPKG). You can also 
select applications by searching a folder for all available InTouch 
applications.
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The Import InTouch Application wizard provides three options to 
select a file or folder to import a Modern application:

• Search for a file or folder

• Select a file

• Select a folder

3 Search for or select a file or folder for the InTouch application you 
want to import.

Search for a folder or a file to import

a Select Find Applications.

b Click the ellipsis button (...) and go to a folder to search for an 
application folder or file.

c Click Find.

A message appears indicating a search is being conducted. 
After the search finishes, the Import InTouch Application 
dialog box lists folders and files that can be imported.

d Select a folder or file from the list to import.

e Click Next.

The Create New Application wizard shows a field to specify the 
base folder path to import the folder or file you selected.

f Continue at step 4.

Select a file to import

a Click File.

b Go to the folder where the file to be imported is located.
InTouch Modern Applications Guide
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c Click the file to be imported. The selected file appears in the 
File name field.

d Click Open. The selected file appears in the top field of the Import 
InTouch Application wizard.

e Click Next.

The Create New Application wizard shows a field to specify the 
base folder path to import the file you selected.

f Continue at step 4.

Select a folder to import

a Click Folder.

b Go to the folder where the folder to be imported is located.

c Click the folder to be imported and click OK. The selected folder 
appears in the top field of the Import InTouch Application 
wizard.

d Click Next.

The Create New Application wizard shows a field to specify the 
base folder path to import the folder you selected.

e Continue at step 4.

4 Click Browse and go to a folder to import the application.

5 Click Next.

The Create New Application dialog box appears with a field to 
enter a name of the folder to place the imported application.

6 Type the name of the folder to place the imported application.

7 Click Next.

The Create New Application wizard updates to show fields to 
enter a name and a description of the imported application. Both 
fields show the existing file or folder name and any existing 
description of the application.

8 In the Name field, accept the existing name or type a new name for 
the application.

9 If you want, enter an optional description of the application in the 
Description field.

10 Click Finish.

After the application is imported, it appears in Application 
Manager’s list of applications.

If the aaPKG file you attempt to import includes non-supported 
components, the import fails and a dialog box with an error is 
shown.
InTouch Modern Applications Guide



14  Chapter 2  Managing InTouch Modern Applications
Migrating to an InTouch Modern Application
You can migrate a legacy or Modern application to the current version 
of InTouch. Migration enables you to convert your legacy InTouch 
applications into Modern applications that support ArchestrA 
graphics. Migrating an application keeps the migrated files in the 
original application folder.

To migrate an application

1 Open Application Manager.

2 From the application list, double-click on an application.

A pop-up message asks if you want to migrate your older InTouch 
application.

3 Click Yes.

A pop-up message asks if you want to migrate the application to be 
able to use ArchestrA graphics.

• If you click Yes, your application is converted to a Modern 
InTouch application.

• If you click No, the application is migrated as a legacy InTouch 
application.

4 Click Yes or No to migrate the application.

If you are migrating a legacy InTouch application to a Modern 
application, you see a pop-up message asking if you want to create 
a back up before migrating the application.

No pop-up messages appear if you are migrating an older version 
of a Modern application. Migration begins immediately.

5 For a legacy InTouch application, click Yes or No to back up the 
application. 

If migration finishes without problems, the migrated application is 
opened.
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Publishing an InTouch Modern Application
You can publish a Modern InTouch application from Application 
Manager. A published Modern application can be distributed like a 
legacy InTouch application, but continues to support the functionality 
provided by ArchestrA symbols. 

You can edit an ArchestrA symbol in published applications using 
basic InTouch operations like copying, cutting, pasting, or resizing. 
However, ArchestrA symbols cannot be modified, nor can new 
ArchestrA symbols be added to a published application.

Also, after publishing a Modern application you cannot edit 
application styles, alarm mapping, or symbol language strings.

To publish an InTouch Modern application

1 Open Application Manager.

2 Select the Modern application that you want to publish.

3 Select the Publish wizard by one of the following methods:

a Select Publish from the File menu.

b Right-click within Application Manager and select Publish 
from the shortcut menu.

c Press the Ctrl + P keys.

The Browse for Folder dialog box appears to select a folder to 
publish the Modern application.

4 Select a folder to publish the Modern application.

If you want to create a folder for the published Modern application, 
click Make New Folder and assign a name to the folder.

5 Click OK.

The Modern application is selected in InTouch Application 
Manager after it is published.
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Deleting an InTouch Modern Application
Deleting an InTouch Modern application permanently deletes the 
application’s folder and associated repository on the local computer. 
Also, the Modern application no longer appears in the list of 
applications shown from Application Manager.

Note:  If a Modern application’s folder is placed on another computer's 
shared directory, the delete operation only removes the application 
from Application Manager. The delete operation does not delete a 
Modern application folder residing on another computer.

To delete a Modern application

1 Open Application Manager.

2 Select the Modern application that you want to delete from the list.

3 Select the Delete wizard by one of the following methods:

a Select Delete from the File menu.

b Right-click within Application Manager and select Delete from 
the shortcut menu.

c Click the Delete icon from the menu bar.

d Press the Del key.

A pop-up message appears and requests confirmation that you 
want to delete the Modern application you selected.

4 Click Yes to delete the Modern application.

The application you deleted no longer appears in the Application 
Manager list of InTouch applications.
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Chapter 3

Configuring InTouch Modern
Applications

This chapter includes the following topics that explain how to 
configure your InTouch Modern applications from WindowMaker.

Configuring Languages for a Modern Application

Configuring the Application Style Library for Modern Applications

Configuring Alarm Priority Mapping for Modern Applications

Exporting ArchestrA Graphics from a Modern Application

Importing ArchestrA Graphics to an Modern Application

Importing and Embedding Custom Client Controls

Exporting ArchestrA Symbol Text Strings from a Modern Application

Importing Text Strings of ArchestrA Symbols to a Modern Application

Configuring NAD Support for Modern Applications
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Configuring Languages for a Modern 
Application

You can configure additional languages for a Modern application that 
can be used in run-time language switching. You can also change the 
text font while configuring an application’s languages.

To configure languages for a Modern application

1 Open the Modern application in WindowMaker.

2 On the Special menu, click Language, and then click Configure 
Languages.

The Configure Languages dialog box appears with buttons to add, 
remove, and set a default language for an application.

To add a language:

a Click Add.

The Add Language dialog box appears to select another 
language by name or locale ID.

b Click the By Name or Locale ID drop-down button and select a 
listed language to add to the application.

c If you want to change the font for the language you are adding 
to the application, click the Font drop-down button and select 
the font for the language.

d Click OK to add the language to the application.

To remove a language:

a Select the language you want to remove from the Configure 
Languages dialog box.

b Click Remove.

The Confirm Delete dialog box appears to verify that you want 
to remove the language from the application.

c Click Yes.

The Configure Languages dialog box refreshes and shows the 
language has been deleted.
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To set a default language:

a Select the language you want to set as the default for the 
application on the Configure Languages dialog box.

b Click Set Default.

The Configure Languages dialog box refreshes and shows the 
default language of the application in the bottom left corner.
InTouch Modern Applications Guide
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Configuring the Application Style Library for 
Modern Applications

You can configure style libraries for a Modern InTouch application. 
Your configuration changes are saved to the Modern application’s 
repository. You can configure application styles for Quality and Status, 
Element Styles, and numeric Format Styles.

• Quality and Status indicators are graphic icons that represent the 
current quality of application data and the state of equipment 
shown by application symbols.

• Element Styles define a set of visual properties that determine the 
appearance of text, lines, graphic outlines, and interior fill shown 
in ArchestrA Symbols or graphics.

• Format Styles provide options to individually configure 
application-wide styles for common types of numbers used in 
Modern applications.

Important:  This section describes the workflow within WindowMaker 
to access a Modern application’s style libraries. For more information 
about editing application styles, see WindowMaker online help or the 
Creating and Managing ArchestrA Graphics User’s Guide.

To configure the Application Style Library for Modern 
Applications

1 Open a Modern application in WindowMaker.

2 On the Special menu, click Configure, and then click Application 
Style Library.

The Configure Application Styles dialog box appears with tabs to 
configure quality and status indicators, graphic Element styles, 
and number format styles.
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3 Select a tab for the application style you want to edit.

4 Refer to WindowMaker online help or the Creating and Managing 
ArchestrA Graphics User’s Guide for more information about 
editing application styles.
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Configuring Alarm Priority Mapping for Modern 
Applications

You can configure the alarm priority mapping of a Modern InTouch 
application to set a priority range for each alarm severity level. 

Important:  This section describes the workflow within WindowMaker 
to map alarm priority ranges to alarm severities. For more information 
about configuring alarm priority mapping and alarm shelving, see 
WindowMaker online help or the Creating and Managing ArchestrA 
Graphics User’s Guide.

To configure Alarm Priority Mappings for Modern 
Applications

1 Open a Modern application in WindowMaker.

2 On the Special menu, click Configure, and then click Alarm 
Priority Mapping.

The Alarms and Events Configuration dialog box appears with 
fields to map a priority range to each alarm severity. The Alarms 
and Events Configuration dialog box also contains fields to enable 
alarm shelving based on alarm severity.

3 In the From Priority and To Priority Range fields, click and enter 
numbers from 1 to 999 to set the lower and upper boundaries of an 
alarm priority range for each alarm severity.

Each priority range should be contiguous without overlap between 
priority ranges. Alarm severity 1 starts at priority 1 by default.

4 In the Shelve column, select or clear the check box to enable alarm 
shelving for each alarm severity.

5 Click OK to save your changes.

Your changes are saved to the Modern application’s Galaxy 
Repository and application folder.
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Exporting ArchestrA Graphics from a Modern 
Application

You can export all ArchestrA graphics from a Modern application to an 
aaPKG file. You can then import the graphics from the file to another 
Modern application on the same or different computer.

You cannot select which ArchestrA graphics to export from a Modern 
application. All ArchestrA graphics are exported from a Modern 
application. 

To export ArchestrA graphics from a Modern application

1 Open the Modern application in WindowMaker containing the 
ArchestrA graphics that you want to export.

2 On the File menu, click Export, and then click All ArchestrA 
Graphics.

The Export ArchestrA Graphics dialog box appears to specify the 
destination folder and the name of the export file.

3 Select the destination folder to export the aaPKG file.

4 If you want, enter the name of the export file in the File name 
field.

The default export file name is ArchestrAGraphics.aaPKG.

5 Click Save.

A horizontal bar shows the progress of the ArchestrA graphics 
being loaded into the export file.
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6 Click Close after the export process is finished. 

7 Using Windows Explorer, go to the destination folder and verify 
the export file has been created.
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Importing ArchestrA Graphics to an Modern 
Application

You can import ArchestrA graphics created in another Modern 
application to the active Modern application running in 
WindowMaker.

Only ArchestrA graphics from the aaPKG file are imported. The 
imported graphics overwrite any graphics of the Modern application 
open for editing in WindowMaker. If the aaPKG file contains 
non-supported components, the import fails and a dialog box with an 
error is shown.

To import ArchestrA graphics to a Modern application

1 Open the Modern application in WindowMaker that you want to 
import ArchestrA graphics.

2 On the File menu, click Import, and then click ArchestrA 
Graphics.

The Import ArchestrA Graphics dialog box appears to specify the 
folder containing an export file of ArchestrA graphics.

3 Using Windows Explorer, go to the folder containing an aaPKG file 
of exported ArchestrA graphics.

4 Select the aaPKG file to import.

The File name field shows the name of the file you selected.

5 Click Open.
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A horizontal bar shows the progress of the ArchestrA graphics 
being imported into the active Modern application. 

6 Click Close after the import process is finished. 
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Importing and Embedding Custom Client 
Controls

You can create a custom Windows client control and embed it in an 
ArchestrA symbol in your Modern application. First, you must import 
the client control to WindowMaker’s ArchestrA Graphic Toolbox. This 
section describes the steps to import and then embed a custom client 
control in separate procedures.

To import a custom client control

1 Create a custom client control for your Modern application.

2 Place the client control in a folder accessible to the computer where 
InTouch WindowMaker is installed.

3 On the File menu, click Import, and then click Client Control.

Important:  Only Modern applications can import custom client 
controls. You cannot import custom client controls to managed, legacy, 
or published InTouch applications.

The Import Client Control(s) dialog box appears with a field to 
enter the name of a custom client control you created.

4 Using Windows Explorer, go to the folder where you placed the 
client control .dll file.

5 Select the client control .dll file and click Open.

WindowMaker updates and shows the custom client control you 
imported in the ArchestrA Graphic Toolbox.
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You can also remove an imported client control from the ArchestrA 
Graphic Toolbox. First, select the client control within the ArchestrA 
Graphic Toolbox. Then, right-click to show the shortcut menu and 
select Delete.

To embed a custom client control in an ArchestrA symbol

1 Open the Modern application in WindowMaker that you intend to 
embed a custom client control.

2 Open the window containing the ArchestrA symbol that you intend 
to embed a custom client control.

3 Select the ArchestrA symbol.

4 From the menu bar, click the Embed ArchestrA Graphic icon.

Important:  You cannot drag and drop the custom client control from 
the ArchestrA Graphic Toolbox onto the ArchestrA symbol. You must 
always embed the custom client control. 

5 Configure your custom client control as needed for the Modern 
application.
InTouch Modern Applications Guide



Exporting ArchestrA Symbol Text Strings from a Modern Application29
Exporting ArchestrA Symbol Text Strings from 
a Modern Application

If your Modern application is intended to support run time language 
switching, you can export the text strings of its ArchestrA symbols to a 
dictionary file. You can then translate the strings within the 
dictionary file to other languages using a text editor, an XML editor, or 
a spreadsheet program like Microsoft Excel.

When you export the symbol text strings, you must specify an output 
folder for the dictionary file. A best practice is to create a separate 
folder for each dictionary file whose strings will be translated into 
another language.

All exported dictionary files follow a naming convention: 
<ModernAppFolderName>AA_<LanguageID>.xml. For example, if a 
Modern application folder name is PumpStation and the language 
being exported is French (Language ID = 1036), then the file name is 
PumpStationAA_1036.xml.

If you will be exporting language strings for different objects at 
different times, use separate target folders to prevent subsequent 
exports from overwriting the first export. 

To export ArchestrA symbol text strings

1 Open the Modern application in WindowMaker.

2 On the Special menu, click Language, and then select Export 
ArchestrA Graphics Locale Data.

The Export Locale Data dialog box appears with fields to select the 
exported language and a folder to place the exported dictionary 
file.

3 Configure the symbol text strings to export.

• In the Languages to export list, select the language dictionary 
to export. The default language is not listed.

• In the Path field, type the folder to which you want to export 
the dictionary file. Click Browse to select an existing folder or 
create a new folder.

4 Click Export. A bar shows the progress of the export operation.
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Importing Text Strings of ArchestrA Symbols to 
a Modern Application

For symbol text, you must import the translated dictionary files for 
each language to enable run-time language switching for those 
languages. All dictionary files for a given language should be placed in 
the same folder.

You can import files for only one language at a time. When you import, 
you select the desired language and specify the dictionary files to 
import.

To import a translated dictionary file

1 Open the Modern application in which you want to import symbol 
text.

2 On the Special menu, click Language, and then select Import 
ArchestrA Graphics Locale Data.

3 Configure the import settings.

• In the Language to import list, select the language dictionary 
to import. 

• In the Path box, specify the folder that includes the dictionary 
file to import. 

• In the Select files to Import box, select the .xml files to import. 
Only files that include the current Modern application folder 
name and the locale ID for the selected language are shown.
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4 Click Import. The import progress is shown.

5 Click Close. The Import Language Dictionary Files dialog box 
appears.

6 Click Close. A summary of the import is shown.

7 Click OK.
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Configuring NAD Support for Modern 
Applications

Network Application Development (NAD) combines a client server 
architecture with automatic notification of application changes. Based 
on user preferences, NAD can automatically distribute updated 
applications from the master to the client nodes running the 
application in WindowViewer.

A Modern application supports NAD in the same way as a legacy 
InTouch application. A Modern InTouch application folder can be 
shared as the NAD master location. A NAD client is notified when 
there are changes to the Modern application on the master node.

In addition to the updates to the components of legacy InTouch 
applications, a Modern application notifies client nodes when there are 
updates to:

• ArchestrA Graphics

• Application Style Library

• Alarm priority mapping

Modern applications impose some restrictions on NAD:

• Any changes to ArchestrA graphics can be loaded to NAD client 
nodes only after restarting WindowViewer. Also, the Notify Client 
command must selected one time in order to generate ArchestrA 
symbols on disk to be available to the NAD client.

• Any changes to a Modern application’s ArchestrA graphics, style 
library, and alarm priority mapping are distributed to client nodes 
only after selecting the Notify Client command from the master 
node.

• The Notify Client command is always enabled for Modern 
applications on the master node. As a result, the state of the Notify 
Client command does not indicate if there are any pending changes 
that need to be sent to client nodes.

• If the Load changes into WindowViewer or Prompt user to load 
changes into WindowViewer options are selected from the client 
node, the user is prompted to restart WindowViewer when any 
changes to a Modern application are detected.

To configure NAD master support for a Modern application

1 Start Application Manager from the NAD master node.

2 Edit the Modern application in WindowMaker.

3 From the Special menu, click Notify Client to generate ArchestrA 
symbols on disk to be available to the NAD client.
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To configure NAD client support for a Modern application

1 Start Application Manager from the NAD client node.

2 Select the Modern application to configure for NAD support.

3 From the Tools menu, click Node Properties.

4 Select the Enable Network Application Development check box. 

5 In the Local working directory box, type the path to the master 
folder that contains the application distributed to client nodes.

6 In Polling period (sec), type the interval in seconds at which a 
client node checks the master node for application updates.

7 In the Change Mode area, select the option that determines the 
action WindowViewer takes when the master application changes.

• Click Ignore changes to have the WindowViewer node ignore 
any changes made on the development node. 

• Click Restart Window Viewer to have the WindowViewer node 
copy over the updated master application (if configured to do 
so) and then restart itself.

• Click Prompt user to Restart to show a message from 
WindowViewer that the application has changed. The operator 
can either restart WindowViewer with the application updates 
or continue using the current application.
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• Click Load Changes into WindowViewer to dynamically load in 
WindowViewer the changes made in the development node. 
This may affect performance for large updates.

• Click Prompt user to load changes into WindowViewer to 
show the operator a message that the application has changed. 
The message prompts the operator to load the changes.

8 Click OK.

9 From a client node, find the shared application from the master 
node in Application Manager.

Users can run the shared application in WindowViewer.
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